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1. Introduction
1.1. Possibilities
Graphicconverter converts the most famous ATARI, Amiga and IBM formats to 
Macintosh formats and back.
Additional you can edit pictures and generate lists with picture informations.

1.2. Requirements
Graphicconverter needs a Mac II (or LC), System 7 and 2 MB free memory.

1.3. Registration
Graphicconverter is Shareware. You can test the program. If you like it, you should 
registrate yourself. 
The registration costs:

Germany $20
Europe $25
Rest of the world $30

Send the money to the following address:
Thorsten Lemke
Insterburger Str. 6
W-3150 Peine
Germany

The registration contains two updates.
A german version is also available.

1.4. Restrictions
Graphicconverter should only be copied in the complete version with the program, 
documentation and 'read-me' file.

1.5. New Features
Version 1.5.1

- program reads CCITT3 and LZW compressed TIFF´s
- diashow shows films (PICS, FLI etc.)
- diashow can display the content of subfolders
- new functions: Segment and Select exist
- you can rotate, mirror and invert selections
- Graphicconverter has new better icons for documents

Version 1.5.2
- you can´t open windows with the same name
- the information window opens direct under then picture window
- I added some forgotten translations
- in the open dialog is a new button “Open PICT with 32 bit”, you need this for 

JPEG compressed PICT´s because the picture utility package analyze 1 bit
Version 1.5.3



- I display now the popup menus in the toolbox so that they are visible everytime
Version 1.5.4

- you can now save pictures in the GIF format
- you can now save TIFF pictures LZW compressed

1.6. Errors
If you find some errors in the program, please send me a list.

1.7. For me
If you have informations about other graphic formats, please send me a copy and a 
disk with some files in that format.

1.8. Thanks
I thank the following persons for their help: Wolfgang for the dither algorithms and 
Jochen for testing.



2. Installation
The Installation is very simple. You only have to copy the Graphicconverter on your 
harddisk. No other files are needed.



3. Menus
3.1. Apple-Menu
The Apple Menu gives you information about the Graphicconverter. Also it contains 
the desk accessories and the files in the apple folder.

Apple Menu

3.1.1. About Graphicconverter…
This function gives you information about the version and the shareware agreement.



3.2. File Menu
The File Menu contains all functions for the in- and output of pictures.

File Menu

3.2.1. New
You get a dialog to set the following things:
① Width - the width of the picture
② Height - the height of the picture
③ Depth - the bits per pixels (1, 2, 4, 8, 16 or 32)
Graphicconverter sets the color table to the system color table of the choosen depth.
3.2.2. Open
You can open a picture or a layout with this function.
You have to select the format with the popup-menu.
You need “Open PICT with 32 bit” for JPEG compressed PICT´s because the picture 
utility package analyze 1 bit.
3.2.3. Save
With this function you can save the content of the active window with its name.
3.2.4. Save as
You save the content of the active window with a new name and format.
You choose the format with the popup-menu. If you select TIFF or IFF then you get a 
additional popup-menu. You select with this menu the type of the compression. You 
should prefer „uncompressed“ for TIFF and „RLE“ for IFF. If you choose “Save only 
selection”, Graphicconverter saves only the selection.
3.2.5. Diashow



You choose one file of a folder. Graphicconverter then displays all pictures in that 
folder.
You stop the diashow with -..⌘
3.2.6. Page Setup
You choose the format and quality for prints.
3.2.7. Print
Graphicconverter prints the content of the active window.
3.2.8. Preferences
You get a dialog to set the preferences:
- automatic display information window
- automatic display toolbox dialog
- don´t show error alerts in the diashow
3.2.9. Quit
You exit the Graphicconverter.
Graphicconverter saves the changes of the preferences automatically.



3.3. Edit Menu
You find in this menu functions to edit pictures and exchange them with other 
applications.

Edit Menu

3.3.1. Undo
You undo the last drawing in the active window.
3.3.2. Cut
You copy the content of the selection in the active window to the clipboard and delete 
the content of the selection.
3.3.3. Copy
You copy the content of the selection in the active window to the clipboard.
3.3.4. Paste
If a PICT is in the clipboard, then the program insert it in the active window.
3.3.5. Clear
Graphicconverter deletes the content of the selection in the active window.
3.3.6. Select all
You select the complete content of the active window.
3.3.7. Select exist
You select only the content of a picture and not the unique coloured borders.
3.3.8. Segment
You destroy the non selected parts of a picture and get the selection as the result.
☞ You save memory with this function.



3.3.9. Clipboard
You get a window with the content of the clipboard.
3.3.10. New Picture with Clipboard
You get a new picture with the content of the clipboard.



3.4. Picture Menu
The Picture menu allows you to change the complete content of a picture.

Picture Menu

3.4.1. Information
A little information window appears in the right, lower edge of the screen, which 
shows some details about the picture in the active window (size, depth etc.).
3.4.2. Size
You get a submenu to select the displaysize of the active window.

Submenu for the size
3.4.2.1. Selection of a procentnumber
You resize the window with the procentnumber.
3.4.2.2. Proportional
You get a dialog to type in a procentnumber in the range from 10 to 1000%.



3.4.2.3. Non Proportional
You get a dialog to type in the width and heigth of the window in pixels.
3.4.3. Colors
You get a submenu to change the colortable of the active window. You can only change
the colors of pictures with a depth from 1 to 8 bit.

Submenu for the colors
3.4.3.1. Greyscale
You change the colortable to a greyscalecolortable.
3.4.3.2. Edit Colortable
You get a dialog to edit the colors of the colortable.
If you click behind the numbers, then you increment or decrement the number by 100.
3.4.4. Invert
You invert the colortable of the picture in the active window. This is only possible for 
picture from 1 to 8 bit.
3.4.5. Special
This sub menu contents very hard function.
☞ Undo not possible!

Submenu for special
3.4.5.1. Burn in
You copy the picture in the changed size in a new bitmap.
☞ Undo not possible!
3.4.5.2. Change Depth
You change the color depth of the picture. Often you get very “funny” results.
☞ Undo not possible!
3.4.6. Rotate
You get a submenu to select the rotation (90˚, 180˚ or 270˚).
3.4.7. Mirror
You get a submenu to select the mirror (horizontal or vertical).
3.4.8. Toolbox



You get a new window with drawingtools. See also “Toolbox”.
3.4.9. Full Screen
You display the picture in front of a black background.



3.5. Dither Menu
The Dither-Menu contains function to convert a color-picture to a black-and-white-
picture.
☞ All dither-functions generate a new picture and don´t change the original.

Dither menu

3.5.1. Floyd-Steinberg
You convert the picture with Floyd-Steinberg-Algorithm in a black and white picture 
with the same size.
3.5.2. Ordered-Dither
You get a submenu to select the squaresize (2x2, 4x4 oder 6x6). Graphicconverter 
dithers your picture with the selected size.
3.5.3. S/W-Picture
You convert the picture direct to a black and white picture.
3.5.4. Dither
You get a submenu the select the size (2x2 to 8x8) of one point in the destination 
picture.
You use dither do print out a color-picture with a printer with a better resolution than 
the  monitor.
☞ If you print a 72dpi picture with 300dpi printer use a 4x4 matrix for dithern.



3.6. Special Menu
The Special menu contains function for additional use.

Spezial Menü

3.6.1. Layout…
You generate and edit with the following two points a layout.
3.6.2. New page
You open a new page.
3.6.3. Options
You get a dialog to change the parameters of the layout:
- font, size und style
- name of a picture
- display the picture on the screen
3.6.4. List…
You generate and edit with the following three points a list
☞ You can open only one list.
3.6.5. Generate
You select in the standard getfile dialog a file of a folder. Graphicconverter opens then 
all files in the folder and looks on them. You get the result in a window. If a list-
window is already open it is closes automatical.
3.6.6. Open Window
If you close a list-window, you reopen it with this function.
3.6.7. Option
You get a dialog to change the parameters of the list:
- font, size und style
- margins



3.6.8. Copy File into Resource
You copy with this function the datafork of a file into the resourcefork of another file:
1. You select the source file.
2. You select the destination file.
2. You select the new resource type.
3.6.9. Generate STR# List
You generate a list with the contents of one STR# resource.
☞ I added this function because it is in ResEdit not possible to print a complete 

STR# resource
3.6.10. Invert SW-Gif´s
You invert all SW-GIF´s of a folder.
☞ You need this function because SW-GIF´s from an IBM are often inverted.
3.6.11. Convert direct GEM to PICT
You convert a GEM-Metafile direct to a PICT.
☞ You don´t lose the vectors of the GEM-Metafile.



3.7. Options Menu
The Options Menu allows you to set the preferences for the top functions.

Options Menu

3.7.1. Load
You get a submenu with the load options.

Load Submenu
3.7.1.1. Correct automatical
If you select one of the following three points the graphicconverter resizes the picture:
Format Source Pixels Dest. Pixels
VGA (256 Colors) 320x200 320x240
EGA (16 Colors) 640x350 640x480
Atari (4 Colors) 640x200 640x400
3.7.1.2. GEM-Metafile
You set with the following four points the options for GEM-Metafiles.
3.7.1.3. 512x512, 1024x1024, 2048x2048
You set the maximal size of a bitmap.
3.7.1.4. Convert Font
You get a dialog. You set the relations between GEM- and MAC-fonts.
3.7.1.5. Change Filetyp
If you check this point graphicconverter automatic sets the filetype of a picture to his 
own when you load a file.
3.7.2. Diashow
You get a dialog to set the preferences for a diashow.



The dialog contains the following points:
① Display name - displays the name of the current picture at the left top corner
② Grow up little pictures - resizes little pictures to the full screen size
③ Minimal showtime - sets the minimal time the picture appears
3.7.3. Anti-Aliasing
You allow the MAC to dither pictures if they have not the original size. You get so a 
better view.
☞ Anti-Aliasing slows the display.



3.8. Window Menu
The Window Menu allows you to arrange and select windows.

Window menu

3.8.1. Arrange
You get a dialog to arrange the open windows. You have the following possibilities:

1. 2.

3. 4.

3.8.2. Windownames
You bring the window with the selected name to the top.



4. Edit
I discripe in this capital the tools to edit a picture.

4.1. Toolbox
You have the following tools in your toolbox:

Lasso
Rubber
Finger

Line
Filled Rectangle
Filled Rounded 
Rectangle

Filled Ellpie
Pen Size
Pattern

Foreground Colour

Pen Mode

Lightness Control

Select
Paint

Fill

Rectangle

Roundes Rectangle

Background Colour

Contrast Control

Ellpie

Zoom

Toolbox

4.1.1. Lasso
You select and move a non rectangluar selection.
4.1.2. Select
You can select or move a frame.
☞ If you press the apple key, you select only the content of the frame.
4.1.3. Rubber
You erase with the background colour.
4.1.4. Paint
You draw with the current foreground colour and pensize.
4.1.5. Finger
You touch a pixel to make his color the foreground colour.
4.1.6. Fill
You fill a figure with the foreground colour and pattern.



4.1.7. Line
You draw a line.with the foreground colour and pen size.
☞ If you press the shiftkey, you can only draw vertical or horizontal lines.
4.1.8. Zoom
You zoom in the picture.
☞ If you press the altkey, you zoom out.
4.1.9. (Filled, Round) Rectangle
You draw a (filled, round) rectangle.with the foregroundcolour, pensize and pattern.
☞ If you press the shiftkey, you can only draw a square.
4.1.10. (Filled) Ellpie
You draw a (filled) ellpie.with the foreground colour, pensize and pattern.
☞ If you press the shiftkey, you can only draw a circle.
4.1.11. Pensize
You get a popup menu to select the pen size between one and ten points.
4.1.12. Pattern
You get a popup menu to select the pattern for filling.
☞ You can tear of the menu.
4.1.13. Foreground and Background Colour
You get a popup menu to select the foreground or background colour.
☞ You can tear of the menu.
☞ If you have a black and white picture the colours toggle between black and white.
4.1.14. Pen Mode
Yout get a popup menu to select the transfer mode. You have the following modes: 
Copy, Or, Xor, Bic, Not Copy, Not Or, Not Xor and Not Bic
4.1.15. Controls
You set the lightness and contrast with the controls.

4.2. Changing the Selection
You change the size of a rectangluar selection with the little boxes on the frame.



5. Layout
You can generate simple layouts. This means that you can place some pictures on a 
page with different sizes.

5.1. Insertion
You get a popup menu to choose one of the open pictures if you click in a layout 
window with pressing the apple key.

5.2. Moving
You move a picture if you click in one and move the mouse.

5.3. Change Size
If you select a picture, you change the size with the little squares.



6. List
The list window gives you an overview about pictures or “STR#” resources.

6.1. Change Page
if you click in the “+” or “-” button you change the page.

6.2. Borders
The black frame shows the printable size. The red border shows the selected frame.



7. Filme
The Graphicconverter can play the following film formats:
① *PICS - Animated PICT´s
② *.ANI- Animated NeoChrome
③ *.FLI - Autodesk Animator
④ *.GIF - Animated GIF´s

If you load a film the Graphicconverter displays in the left bottom corner of the 
window a play button.
If you click in this button you get the film. You stop the film with a mouse click.



8. Shortcuts
8.1. Everytime
Shortcut Result
Alt key and click in the window title You get a popup menu with all open 

windows. You bring the selected 
window to the front.

8.2. In Pictures
Shortcut Result
Ctrl key in the content You get a popup menu to select the 

picture view size.
Alt key in the content You change the drawing funtion to 

finger.
Cursor keys You change the size of a rectangluar 

selection.

8.3. In Layouts
Shortcut Result
Apple key and click in the content You get a popup menu with all open 

pictures to insert one.
Apple key and click in the content over 
a picture

Yout get a popup menu to select the 
picture size.



9. Formats
I show in the table the picture formats my program can read and write.
Name Read Write Discription
PICT x x standard Macintosh format, include bitmaps or vectors
MacPaint x x black and white picture, Resolution 576x720 pixels
TIFF x x complex format from 1 to 24 bit per pixel

Graphicconverter reads all classes (B, G, P, R)
and the following compression algorithms: 
uncompressed, packbits, CCITT3 and lzw
it writes uncompressed, lzw and packbits

PICS x Animated PICT´s
GIF x x from CompuServe Incorporated for pictures from 1 to 

8 bit per pixel
PCX x x from PC-Paintbrush for pictures with 1, 4 or 8 bit per 

pixel
SCR x x from the Capture program for word for Windows and 

DOS, same as PCX
BMP x standard Windows format, not compressed
PIC x for pictures with 16 bits per pixel, not compressed
FLI x from Autodesk Animator, contains 8 bit film with the 

size 320x200 pixels
IFF x x standard format of the Amiga
LBM x x same as IFF for the IBM
PAC x from ATARI program STAD for black and white 

pictures with the size 640x400 pixels
Degas x from the ATARI program Degas for the following 

pictures:
- 320x200 pixels, 16 colours (*.PI1, *.PC1)
- 640x200 pixels, 4 colours (*.PI2, *.PC2)
- 640-400 pixels, 2 colours (*.PI3, *.PC3)

NEO x from the ATARI program NeoChrome for 320x200 
pixels, 16 colours pictures

PIC x ATARI screen shot, 640x400 pixels, 1 bit
SPC x from the ATARI program Spectrum 512 for 320x200 

pixels, 512 colours pictures, automatically converted to
16 bit

ANI x film from NeoChrome, you need additional a NEO-file
GEM x GEM-Metafile, vector format from the ATARI program

GEM-Draw
Imagic x from ATARI program Imagic, contents pictures in the 



three ATARI standard formats


